6.2
Cookbook

sitecore

compelling web experiences

Sitecore CMS 6.2

Client Configuration
Cookbook

Features, Tips and Techniques for CMS Architects and Developers

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.



Sitecore CMS 6.2 Client Configuration Cookbook @ S|teco re

Table of Contents
(O g1 o] (=] o A 1 0T [ Tox 1o T o R 5
Chapter 2  COMMON PrOCEAUIES .......ccuiiiieiiee e e e ettt e e e e e st e e e e e e st re e e e e e e s s santaaeeeaeeesaasntenaeaeeeesannnneens 6
P2 R o o ¢ To g = (o ToT=To 11| £ EPP RPN 7
2.1.1 How to Select a Database in the Sitecore DesKtOp ......ccvvevvieeiiiiiiiiieii e 7
2.1.2 How to Show or Hide the Standard FIelds ... 7
2.1.3  How to Show Or Hide RAW VAIUES ......ccceiiiiiiiiiiiiee ettt e e 7
2.1.4 How to Show or Hide the Developer Tab ... 8
2.1.5 How to Copy the ID or Path of an Item to the Windows Clipboard ..............cccccevniiiiiiniiieeennnn 8
2.1.6 How to Enter @ Class SIGNATUIE ........cocuuiiiiiiiiie ettt ettt e e 8
Chapter 3 Data Templates and IEEIMS ......cooiiiiiiiiiiii ettt e e e s e nbe e e e e e 9
3.1 (=T g Y o] o1=T= 1= [l TSP PP PPPPPPPPIN 10
I 700 0 R (oo 1 T 10
HOW t0 Set the 1CON fOr @N IEEM ... it e st e et e e e sbbeeeeans 10
How to Set the Default Icon for All Items Based on a Data Template .............ccooe oo, 10
How to Change the Default Icon for All HEMIS . ... 11
How to Configure the 1con Selection MENU.......cccooo oo 11
0 2 o 1T o =T o T 1 (=T o 1 SRS 11
How to Show or Hide HIdden ItEMS .........ouiiiiiiiie e eeeeeee e e s 11
HOW t0 ShOW OF HIdE @N IEEIM ...eeeiiiiei e e e st e e e e e s e e eaaeeeee s 11
0 I B = (] (= Tox (Yo [N 1 1= o 1 SRRSO 11
How to Protect or UNProtect @n IeM ... 12
B L4 M StYIES ... —————— 12
How to Configure the Style of an Item Name in the Content Tree............coe oo, 12
315 DISPlaY NAIME ... —————— 13
How to Set the Display Name for an em ... 13
3.1.6  Context-SensSitive Help ... 14
How to Set Item Context-SeNSItiVe HEIP ......ccooeieiece e 14
3.2 Data TeMPIAIE SECHONS ....cciiteiiieiiit ittt e ettt e e e e e e e bt e e e e nbneeeeaneee 15
3.2.1 Data Template SECON ICONS .......uuiiiiiiiie ettt 15
3.2.2 How to Set a Data Template SECHON ICON .......coocuiiiiiiiiiie e 15
3.2.3 Data Template SeCtion SO OFUEr .........cciiiiiiieiiie et 15
How to Sort Data TEMPIALE SECLONS .......uiiiiiiiiie ittt sbb e e breee e 16
How to Set the Sort Order Property of a Data Template Section Definition Item ..............cccceee.. 16
3.3 D= U= T =T 0 0] 0] £ (= = Lo £ 17
3.3.1 Data Template Field Headers and Context-Sensitive Help ............ccccoeee e, 17
How to Set the Title for a Data Template Field ..., 17
How to Set Context-Sensitive Help for a Data Template Field.............cccooooeie i, 17
3.3.2 How to Style a Data Template Field................ooo oo, 17
3.3.3 Data Template Field SOrt Order..........cooooiiiiiiii i 18
How to Sort Data TeEMPIAe FIElAS ........oueiiiiiiiiee et 18
How to Set the Sort Order Property of a Data Template Field Definition ltem ............cccooveiveennn.n. 18
3.3.4 Rich Text Editor (RTE) CoNfiguration............cooiiiiiiiiiiiie ettt 18
RTE Profile Definition ItemM REFEIENCE .......covii i 19
How to Configure RTE Profiles .......ueeiiiiiiee ettt 19
How to Determine the Path to an RTE Profile ... 20
How to Set the Profile for an RTE Template Field Definition Item ............cccccooiiiiiiieee, 20
How to Add Features to an RTE Profile ... 20
How to Set the CSS Used by RTE FIelUS ....ccoooiiiiiiiiiie et 20
How to Limit the CSS Styles Visible in RTE FIelaS ...t 21
How to Configure the RTE HTML Element Types Drop-DOWN MeNU...........cooviiuiiiiieieeeiniiiiiieeenn 21
How to Enable Snippets in an RTE Profile ... 22
How to Add a Snippet to an RTE Profile ........c..ooi i 22
How to Control the Markup Inserted by the Enter KeY.........ooouiiiiiiiiiiiiiiieeee e 22
How to Disable the RTE HTML Tab for SOme Or All USEIS .......covveiiiciiiiiiiiee s ccieee e neeeeee e 23

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 2 of 62



Sitecore CMS 6.2 Client Configuration Cookbook @ S|teco re

3.4 Custom User Interfaces in Data TEMPIALES ......ccovviiiiriiiiie et e e e e e e 24
I A I o TN [ = Ta g U= =Y o R 1Y o1 SRS 24
How to Create an IFrame Data Template Field ... 24
I N 1 (= 0 T =T 11 (o] PSRRI 24
HOW t0 CONfIGUIE ITEM ETITOrS ...ooi ettt e et e e sb e e e e snneee e 25
How to Create a CUStOM IteM EQItOr .........coiiiiiiiiiieie et e e sebeeeee e s 26
3.5 [a1S1=] 1 A O o] 1 To] 1 KO PP PP OTPPPN 27
Chapter 4  Data ValIOALION .......ccoiiiiiieiiiiiee ittt e et e e e st e e e e e anb e e e s aabreeeeanees 28
4.1 ValidAtION OVEIVIEW ...ttt e e e e ettt e e e e e e s s s bttt et e e e e e e aannbabeeeeaeeseaannteneeeaaens 29
N I o =10 Y AV = o F= 1T o SRS 30
4.2.1 Data Template Field Validation .............coovieiiiiiiiiiiiice e e e e e e 30
o = (o I Y/ o T -1 [T = L1 T RSP 30
e T 11=10 IV 1T F= T o 1SS TPPPRPRP 30
4.2.4  Standard ValidatioN ...........cooiuiiie it e et e et e e ab e e st e e e raeeeean 30
4.2.5  Global ItemM ValidatioN ........ccocueiiiiiiiiie ittt e e et e e s sbae e e e snreeeean 30
4.3 Validation ErTOr LEVEIS .......eeeiiiieeeie ettt e e e e et e e e e e e s e et eeeeaae s 31
4.4 Configuring Validation RUIES ........c.ouiiiiiie e e 32
4.4.1 How to Configure Quick Action Bar Validation RUIES ...........cccceiiiiiiiiiiiiiiiic e 32
4.4.2 How to Configure Validate Button Validation RUIES.............ocoviiiiiiiiiiiii e 32
4.4.3 How to Configure Validation Bar Validation RUIES ... 32
4.4.4 How to Configure Workflow Validation RUIES ............cooiiiiiiiiiiiiiii e 32
4.45 How to Create a Workflow Command or State Validation ACtion ...........cccccooviiiiiiieieiniininnnen 32
4.4.6 How to Configure Validation Rules for All Instances of a Data Template Field Type............. 33
4.4.7 How to Configure Validation Rules for All -e€MS: ........coovvviiiiiiiiee 33
4.4.8 How to Configure Validation Rules for an Individual Item or All tems Based on a Specific
LD F= = N =T 0] 0] == 33
4.4.9 How to Configure Validation Rules for a Specific Data Template Field..............ccccceeiviieeenne 34
4.4.10 Default ItemM ValIOIS .....coiii i e e s e e e s s e raeeeeee s 34
4411 Default Field ValidAtors ..........c.uviiieiie i e e et e e e e e e s s snnreeeeeaee s 34
4.5 REQISErING VAIIGALOIS ......eiiiiiiiiieiiiiee ettt st eb e e s e bt e e e e nbn e e e e neee 36
451 How to RegiSter @ VAlIUALOF .........ouuieiiiiiiie ettt e et e e sbneee e 36
4.5.2 How to Register a Regular Expression Field Validator ............ccccoovveiiiiiieiiiiiieciec e 36
4.5.3 How to Register an Integer Field Validator .............cccccevvviviiiiii 37
4.5.4 How to Register an Integer Range Field Validator.............cccccceveviviiiiii 37
455 How to Register a Maximum Length Field Validtor............cccccvvveviiii 37
45.6 How to Register Validators for Specific ltems and Items Based on Specific Templates......... 37
4.5.7 How to Disable Default Validation RUIES ..............oooiiiiiiiiiiiie e 38
4.5.8 How to Override the Default Error Level for a Validator ... 38
4.6 (@I 1S3 o] 4 IV 2= 1 o £ o] =PSSOSR 39
4.6.1 How to Implement a Custom Validator ............ccooiiiiiiiiiiiei e 39
4.6.2 How to Implement a Custom Validator ............cooiiiiiiiiiiiiee e 39
4.7 RV 2= 1T oo o o3 1T 1SR 41
4.7.1 How to Create a Validation ACHON .........ccuiuiiiiiiiiiiiee e e e e e e e 41
4.7.2 How to Use a Validation ACLON ...........uuiiiiiiiiiee et e e 42
Chapter 5 The Page EQItOr ......cccooiiii i 43
51 Lo Yo L= o 1 0] @ =T T 44
5.1.1 The Design Pane of the Page Editor ..., 44
5.2 L F= Lot =Y g To] (o [T Y= 11T £ 45
5.2.1 How to Create a Placeholder Settings Definition Item ... 45
5.2.2 How to Configure Placeholder Settings for a Data Template or an Individual ltem................ 46
5.3 = To T o 11 (o] 1Y, [ To = PR a7
5.3.1 How to Determine the Page Editor MOUE .........occuiiiiiiiiiiiiiiie e a7
5.3.2  PAge EdItOr MOUES.......ooiiiiiiiiie ittt ettt e et e et e e e snbae e e e e a7
54 T L) =T =SS 49
5.4.1 How to Implement an Edit Frame Menu COmMmaNnd............ccceeiiiiieeiniieee e 50
5.4.2 How to Define an Edit Frame MENU .........ooouuiiiiiiiii it 50
5.4.3 How to Insert an Edit Frame in a Layout or Sublayout ... 51
5.4.4 How to Insert an Edit Frame in an XSL ReNAErNG .........cceiiiiiiiiiiiiiiiiaae e 51

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 3 of 62



Sitecore CMS 6.2 Client Configuration Cookbook @ S|teco re

T T =l [ = U 1= 0 o 0] 0 1= 1= SR 51

ST ST I 0T 1= o o 1o PP PP PP RPN 52
5.5.1 How to Use the Default Field EQITOr ..........cooiiiiiiiieee e 52
5.5.2 How to Implement a Custom Field EAItOr ...........ccuveiiiiiiiiiiiie e 53
Chapter 6 Security Based Configuration FEATUIES ...........coicuiiiiiiiiiieiiiie et 54
6.1 Sitecore Client SECUILY ROIES ...t 55
6.2 SECUNLY PIESELS .ttt ettt e e e bt e e e e a b et e e e e hb et e e e aab bt e e e anbr e e e e anbreeeeannee 57
6.2.1 HOW t0 Create @ SECUNLY PrESEL......coiuiiiiiiiiii ettt 57
6.2.2  HOW t0 APPIY @ SECUNLY PrESEL......oiiiiiiiiiiit et 58

6.3 Data TemPplate FIild SECUNLY .....uiiiiiii e cre e s e e e e s s er e e e e s s s r e e e e e e e s nnnnreees 59
How to Configure Data Template Field SECUNLY ........cceiiiiiiiiiiiiie e 59
Chapter 7 Sitecore ClIeNt RSS FEEAS ....uuuiiiiii it ii e e e sttt e e e s st e e e e e e s s st e e e e e e s e snnntaaaeeeaeeseaanns 60
7.1 Sitecore Client RSS FEEAS OVEIVIEW ........ccuviiiieiieeeiiie e sireesiee st sne e nnne e 61
7.1 1 WOTKFIOW FEEMA ...ttt e s r e e s e e 61
7.1.2  WOIKFIOW State FEEM ......oi it 61
7.1.3  HEM UPAAtEd FEEM........oii i e et e e rbr e e 61

7.2 Sitecore Client RSS Feeds Configuration............c.ocuiiioiiiiieeiiiiie et 62
7.2.1 The ClientFeeds.MaximumltemsInFeed Setting .........cccccevrrieeiiiiie e 62
7.2.2 The ClientFeeds.ItemEXPiration SettiNg .........ccooiiiiiiiiiieiiee e 62

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 4 of 62



Sitecore CMS 6.2 Client Configuration Cookbook @ S|teco re

Introduction

This cookbook provides information, tips, and techniques for CMS architects and
developers to optimize Sitecore client user interface usability.

This document contains the following chapters:
e Chapter 1 — Introduction
e Chapter 2 — Common Procedures
e Chapter 3 — Data Templates and Items
e Chapter 4 — Data Validation
e Chapter 5 — The Page Editor
e Chapter 6 — Security Based Configuration Features

e Chapter 7 — Sitecore Client RSS Feeds

! For client hardware requirements, see the Installation guide at
http://sdn.sitecore.net/Products/Sitecore%20V5/Sitecore%20CMS%206/Installation.aspx. For
instructions to configure Internet Explorer, see the Internet Explorer Configuration Reference manual
at http://sdn.sitecore.net/Reference/Sitecore%206/IE%20Configuration%20Reference.aspx.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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Common Procedures

This chapter provides instructions for common procedures required by other
procedures described in this and other documents.

This chapter contains the following section:

e Common Procedures
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2.1 Common Procedures

This section provides instructions for common procedures required by other procedures described in
this and other documents.

2.1.1 How to Select a Database in the Sitecore Desktop
To select a database in the Sitecore desktop:

1. Inthe browser, access the Sitecore login page, such as http://localhost/sitecore.

2. Inthe Sitecore login page, enter your Sitecore username and password.

3. Inthe Sitecore login page, click Options, and then double-click Desktop. The Sitecore
desktop appears in the browser.

4. In the Sitecore desktop, in the lower right corner, click the database icon, and then click the
database name. The Sitecore desktop refreshes, closing any open applications. If you open
the Content Editor or other applications within the Sitecore desktop, they will access the
database that you selected until you log out or select a different database.

5. Inthe Sitecore desktop in the selected database, in the lower left corner, click Sitecore, and
then click Content Editor. In the Sitecore desktop in the selected database, the Content
Editor appears, allowing you to navigate the selected database.

Important
To reduce the potential for making changes to a database unintentionally, always select the Master
database after working with one of the other databases.

Note
Unless otherwise specified, all procedures in this and other Sitecore documentation assume that you
have selected the Master database.

2.1.2 How to Show or Hide the Standard Fields
To show or hide the standard fields:
1. Inthe Template Manager or the Content Editor, click the View tab.
2. Inthe Template Manager or the Content Editor, on the View tab, in the View group, enable
or disable Standard Fields.

Note
The visibility of the standard fields can affect Sitecore client performance.

2.1.3 How to Show or Hide Raw Values
You can investigate the text value of a field by viewing its raw value. For example, you may view the
raw value of a field to determine the attributes that Sitecore stores for an element.

Note
Whenever possible, use constructs that abstract field values rather than accessing raw field values

directly.
To show or hide raw values:
1. Inthe Template Manager or the Content Editor, click the View tab.

2. Inthe Template Manager or the Content Editor, on the View tab, in the View group, enable
or disable Raw Values.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.
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2.1.4 How to Show or Hide the Developer Tab
The Developer tab provides convenience features for developers working with Sitecore solutions.
To show or hide the Developer tab:

e Inthe Content Editor, right-click the tab strip, and then enable or disable Developer.

csentation  Searity  View

:ﬂ p Cut Rename
pacte LM Copy || I Display Name || % Doy

Review
Analyze
Publish
versions
Configure
Presentation
Security
View

My Toolbar
Developer

Reset

-3ASDFFETOEFS}

mple Item - {75035F SE-CBCE-460 1-AFDA-4143F9B55

Customize

2.1.5 How to Copy the ID or Path of an Item to the Windows Clipboard

To copy the path to an item to the Windows clipboard:

1. Inthe Template Manager or the Content Editor, select the item, and then click the Content
tab.

2. Inthe Quick Info section, click and drag the mouse across the value of the ID or Item Path.
To copy the path to the Windows clipboard, press CTRL-C, or right-click the selected text,
and then select Copy.

Tip

You can also copy the ID or path to an item by using the ID and Path commands in the Show group
on the Developer tab. For more information about the Developer tab, see the section How to Show
or Hide the Developer Tab.

2.1.6 How to Enter a Class Signature
A class signature identifies a class in a .NET assembly (.d11 file).
To enter a class signature:

1. Enter the following prototype:

Namespace.Class, Assembly
2. Replace Namespace with the namespace containing the class.
3. Replace Cclass with the name of the class.

4. Replace Assembly with the name of the assembly containing the class, without the .d11
extension.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.
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Data Templates and Items

This chapter provides tips and describes techniques for configuring data templates
and items, including controlling item, section, and field appearance, custom item
editors, and insert options.
This chapter contains the following sections:

e |tem Appearance

e Data Template Sections

e Data Template Fields

e Custom User Interfaces in Data Templates

e Insert Options

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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3.1 Iltem Appearance

You can use the following features to control the appearance of items in the content tree. A field in the
standard template defines the icon for each item.

3.11 Ilcons

Sitecore user interfaces, including the content tree in the Content Editor, display an icon next to each
item.

Developers use icons:

e To differentiate specific items visually.

e To differentiate items based on specific templates visually.
If an item does not specify an icon, the content tree displays the icon specified in data template
associated with the item. If that data template does not specify an icon, then the content tree displays

the icon specified by the value attribute of the /configuration/sitecore/settings/setting
element in web.config with name DefaultIcon.

Note

Sitecore supports theming. Sitecore interprets relative icon paths as relative to the
/sitecore/shell/themes/standard directory. For example, the value
applications/16x16/star yellow.png iS equivalent to
/sitecore/shell/themes/standard/applications/16x16/star yellow.png.

Note
An icon can be an arbitrary URL of an image.

How to Set the Icon for an Item
To set the icon for an item:
1. Inthe Content Editor or the Template Manager, select the item.
2. Inthe Content Editor or the Template Manager, click the Configure tab.

3. Inthe Content Editor or the Template Manager, on the Configure tab, in the Appearance
group, click the Icon command. An icon selection menu appears.

4. In the icon selection menu, select an icon, or click More Icons and use the icon selection
dialog to select an icon.

Note
The icon selection dialog may load slowly when presenting a large number of images in a single
directory.

Tip
As a shortcut to access the icon selection dialog, in the editing pane, click the Content tab, and then
click the icon in the item title bar.

Important

Rather than setting the icon for individual items, set the icon for each data template. The icon of a
data template is the default icon for items based on that template, including the standard values item.
How to Set the Default Icon for All tems Based on a Data Template

To set the default icon for all items based on a data template:

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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1. Inthe Template Manager or the Content Editor, select the data template definition item.

2. Inthe Template Manager or the Content Editor, set the icon in the data template definition
item. For instructions to set the icon, see the section How to Set the Icon for an Item.

Important

Set the icon in the definition item for each data template, not in the standard values item for the data
template. If you only set the icon in the standard values item for the data template, the icon does not
apply to the data template itself; the icon shown for the data template in the content tree remains the
default icon.

How to Change the Default Icon for All Items

To set the default icon for all items for which the item, its data template, and the standard values item
associated with its data template do not define an icon, in the web. config file, in the
/configuration/sitecore/settings/setting with the name DefaultIcon, setthe value
attribute to the default icon path.

How to Configure the Icon Selection Menu

To configure the icons that appear in the icon selection menu, edit the file
/Bpp_Config/Icons.config. Each collection element defines a row, and contains a pipe-
separated list of absolute or relative paths to icon files.

3.1.2 Hidden Items

Hidden items do not appear in the content tree for users who do not have permission to show hidden
items, or have not chosen to show hidden items.

How to Show or Hide Hidden Items

To show hidden items, the user must be an administrator, or a member of either the Sitecore Client
Developing role or the Sitecore Client Maintaining role.

To show hidden items:
1. Inthe Content Editor or the Template Manager, click the View tab.

2. Inthe Content Editor or the Template Manager, on the View tab, in the View group, enable
or disable Hidden Items.

How to Show or Hide an Item

To hide or show an item, the user must be an administrator, or a member of the Sitecore Client
Configuring role.

To show or hide an item:
1. Inthe Content Editor or the Template Manager, select the item.
2. Inthe Content Editor or the Template Manager, click the Configure tab.

3. Inthe Content Editor or the Template Manager, on the Configure tab, in the Attributes
group, click Hide Item to hide the item, or click Make the Item Visible to show the item.

3.1.3 Protected Items

No user can edit protected items through Sitecore user interfaces.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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How to Protect or Unprotect an Iltem

To protect or unprotect an item, the user must be an administrator or a member of the Sitecore Client
Configuring role.

To protect or unprotect an item:
1. Inthe Content Editor or the Template Manager, select the item.
2. Inthe Content Editor or the Template Manager, click the Configure tab.

3. Inthe Content Editor or the Template Manager, on the Configure tab, in the Attributes
group, click Protect Item to protect the item, or click Unprotect Item to unprotect the item.

3.1.4 Item Styles

Item styles control the appearance of the names displayed for each item in the content tree.
Developers use item styles to highlight and differentiate visually specific items or items based on
specific templates. For example, certain system items appear in green text by default, and proxy items
to appear grayed out.

To style individual items, developers apply item styles to items. More commonly, developers apply
items styles to data templates to style all items based on those templates.

How to Configure the Style of an Item Name in the Content Tree

You can use the tree node style to configure the styling of item names in the content tree. To
configure the tree node style for item names:

1. Inthe Template Manager or the Content Editor, select the standard values item or the
individual item

2. Inthe Template Manager or the Content Editor, click the Configure tab.

3. Inthe Template Manager or the Content Editor, on the Configure tab, in the Appearance
section, click Tree Node Style and the Tree Node Style dialog appears:

3 Sitecore — Webpage Dialog E]
Tree Node Style
Use CSS styles to define how the current item appears in the content tree.
Preview:
Site Root
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4. Inthe Tree Node Style dialog, style dialog, enter CSS styles, or click Edit to use the Web
CSS Editor dialog. For example, enter COLOR: red; to set the color of the font to red.

B} web CSs Editor -- Webpage Dialog |
o " Character Spacing

2! Font: Font style: Size:

+ |(Default Font) | |Normal +| [10px =
g Arial ltalic _&in

LE Arial (fantasy) Oblique 2mm

5 Arial Black Bold 1em

= |Blackadder ITC >| |Bold italic x| |spt x|
I Color: " Disable Color

2]

=3

& Effects

™ Undertine ™ Small Caps

= I™ Stikethrough ™ AlCaps

2 . L

S-_’ [~ Overline ™ Capitalize

= I Blink ™ Hidden

™ No text decoration

o

2

=

g

Preview
AaBbYyGeLllj
Ok Cancel

Note

Sitecore uses COLOR: green for system items and COLOR: gray for proxy shadow items. Avoid using
these tree node styles for other purposes.

3.1.5 Display Name

If defined, the display name of an item appears in user interfaces such as the content tree instead of
the name of the item.?

Developers use display hames:

e To provide helpful item names in the content tree without affecting the default URL for content
items.

e To allow characters not allowed in item names to appear in the content tree.

Warning

Use display names in limited cases, such as where you must display characters not allowed in item
names.

How to Set the Display Name for an Item
To set the display hame for an item:
1. Inthe Content Editor or the Template Manager, select the item.
2. Inthe Content Editor or the Template Manager, click the Home tab.

3. Inthe Content Editor or the Template Manager, on the Home tab, in the Rename group,
click Display Name. The display name prompt appears.

% For information about using display names in URLS, see the Dynamic Links guide at
http://sdn.sitecore.net/Reference/Sitecore%206/Dynamic%20Links.aspx
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4. Inthe dialog box that appears, enter the display name for the item.

3.1.6  Context-Sensitive Help

Editorial interfaces can display helpful information about the selected item and its data template.

Developers use context sensitive help:
e To provide useful information to users working with items based on a specific data template.

e To provide useful information to users working with a specific item.

The item title bar displays the short description defined in the help properties of the item or its data
template. When you move the mouse over an item in the content tree, Sitecore displays the long
description of the item or its template as a tooltip.

If the developer has not defined any help properties for the item, Sitecore uses the help properties
defined in the item’s data template.

How to Set Item Context-Sensitive Help
To set context-sensitive help for a data template or an individual item:
1. Inthe Template Manager or the Content Editor, select the standard values item or the
individual item.
2. Inthe Template Manager or the Content Editor, click the Configure tab.

3. Inthe Template Manager or the Content Editor, on the Configure tab, in the Appearance
group, click Help and the Help Texts dialog box appears.

2 Sitecore — Webpage Dialog 3

=—| Help Texts

= Write the help texts for the current item,

Short Description (ToolTip):
[The start page of a site. Also known as the Home page

Long Description:

Help Link:

Far example: http:/fwww.sitecore, net/Product.aspx

4. Inthe Short Description field, enter a short description of the type of item or the individual
item.

5. Inthe Long Description field, enter a long description of the type of item or the individual
item.
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3.2 Data Template Sections

Each data template contains one or more sections, and each section contains one or more fields.
Data template sections allow developers to organize fields into related groups. Organizing fields into
sections avoids the appearance of monolithic data entry forms, and allows users to collapse sections
of the form that they are not currently using. Developers also use data template sections to contain
groups of fields that you can reuse in multiple data templates.

Data templates with large number of sections, and sections with large numbers of fields, can reduce
usability and performance. To improve performance, it is especially important to avoid creating data
templates with large numbers of Rich Text Editor (RTE) fields. Instead, developers use other field
types, or represent the data using a hierarchy of items associated with different data templates.

Logical sorting of data template sections and fields helps users locate the fields they wish to update.
Consider sorting sections and fields in the same order that presentation components render field
values in page views. Alternatively, place the sections and fields that are most important or updated
most frequently towards the top of the data template.

Using appropriate data template section and field names helps users locate the fields they wish to
update. For example, if the data template for news articles defines only a few fields such as Author
and Date, consider placing those fields in a section named News, and do not use this section name
for any fields that are not specific to news articles. Overly general section names such as Data do not
provide the same contextual assistance in templates that contain numerous fields.

If a data template and any of its base templates define sections with a common name, the Content
Editor renders all the fields in those sections as a single visual section. The sort order property of
sections and fields controls their order relative to other sections and fields in the template.

3.2.1 Data Template Section Icons

Data template section headers in the Content Editor display the icons associated with each data
template section. Developers specify icons for data template sections to help users locate the fields
they want to edit.

Note

If a data template section definition item does not specify an icon, then Sitecore uses the icon
specified by the value attribute of the /configuration/sitecore/settings/setting element
in web.config with name DefaultIcon.

3.2.2 How to Set a Data Template Section Icon
To set the icon for a data template section:

1. Inthe Template Manager or the Content Editor, select the data template section definition
item.

2. Inthe Template Manager or the Content Editor, set the icon for the data template section
definition item. For instructions to set the icon for an item, see the section How to Set the Icon
for an ltem

3.2.3 Data Template Section Sort Order

You can sort data template sections using Template Builder, or by setting the sort order property of a
data template section definition item.

Note
To control the order of sections when a data template and its base templates define different data
template sections, set the sort order property of data template section definition items.
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How to Sort Data Template Sections
To sort the data template sections in a data template:
1. Inthe Template Manager or the Content Editor, select the data template definition item.

2. Inthe Template Manager or the Content Editor, in the editing pane, click the Builder tab.
The Template Builder appears.

In the Template Manger or the Content Editor, click the Builder Options tab.
In the Template Builder, click in the section name to select that section.

In the Template Builder, in the Sorting group, click Up, Down, First, and Last to sort the
section relative to the other sections in the data template.

How to Set the Sort Order Property of a Data Template Section Definition Item
To set the sort order property of a data template section definition item:

1. Inthe Template Manager or the Content Editor, select the data template section definition
item.

2. Inthe Template Manager or the Content Editor, show the standard fields.

For instructions to show the standard fields, see the section How to Show or Hide the
Standard Fields.

3. Inthe Template Manager or the Content Editor, in the Appearance section, in the
Sortorder field, enter a numerical value.

4. Inthe Template Manager or the Content Editor, hide the standard fields.

For instructions to hide the standard fields, see the section How to Show or Hide the Standard
Fields.
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3.3 Data Template Fields

You can use the features described in this section to optimize the usability of data template fields.

3.3.1 Data Template Field Headers and Context-Sensitive Help

The Content Editor displays field headers above each field. Developers use field headers to provide
instructions and contextual information to users working with a field value.

Each field header consists of a number of elements, including:

The field title, which defaults to the field name.
e Thetoken [standard wvalue], if the field contains its standard value.

e Thetoken [shared], if the field contains a value shared to all versions of the item in all
languages.

e The token [unversioned], if the field contains a value that is not versioned, but may differ
by language.

¢ Field editing controls appropriate for the field type.

The long description of the field appears when the user moves the mouse over the field title.

For fields that define a help link, the title and short description in the field header link to the specified
URL.

How to Set the Title for a Data Template Field

To set the title for a data template field, causing the field label in the Content Editor to differ from the
name of the field definition item:

1. Inthe Template Manager or the Content Editor, select the data template field definition
item.

2. Inthe Template Manager or the Content Editor, in the Data section, in the Title field, enter
the title of the field.

How to Set Context-Sensitive Help for a Data Template Field
To set context-sensitive help for a data template field:

1. Inthe Template Manager or the Content Editor, select the data template field definition
item.

2. Inthe Template Manager or the Content Editor, click the Configure tab.

3. Inthe Template Manager or the Content Editor, in the Appearance group, click Help and
the Help Texts dialog box appears.

4. Inthe Help Texts dialog box, in the Short Description field, enter a short description of the
field.

5. Inthe Long Description field, enter a long description of the field.

6. Inthe Help Link field, enter the URL of a resource containing helpful information about the
field.

3.3.2 How to Style a Data Template Field

To style a data template field:
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1. Inthe Template Manager or the Content Editor, select the data template field definition
item.

2. Inthe Template Manager or the Content Editor, click the Configure tab.

3. Inthe Template Manager or the Content Editor, in the Appearance group, click Tree Node
Style and the Tree Node Style dialog box appears.

4. Inthe Tree Node Style dialog box, enter CSS styles, or click the Edit button to use a CSS
style wizard. For example, enter HEIGHT : 600px; to set the height of a Rich Text Editor, or
FONT-WEIGHT:bold; to style the text in a single-line text field.

3.3.3 Data Template Field Sort Order

Explicitly set the sort order property of data template field definition items to control the order of fields
when a data template and its base templates define the same data template sections.

How to Sort Data Template Fields
To sort data template fields:
1. Inthe Template Manager or the Content Editor, select the data template definition item.

2. Inthe Template Manager or the Content Editor, in the editing pane, click the Builder tab.
The Template Builder appears.

In the Template Builder, click in a field name to select that field.

4. Inthe Template Builder, in the Sorting group, click Up, Down, First, and Last to sort the
field relative to the other fields in the section.

How to Set the Sort Order Property of a Data Template Field Definition Item
To set the sort order property of a data template field:
1. Inthe Template Manager or the Content Editor, edit the data template field definition item.
2. Inthe Template Manager or the Content Editor, show the standard fields.

For instructions to show the standard fields, see the section How to Show or Hide the
Standard Fields.

3. Inthe Template Manager or the Content Editor, in the Appearance section, in the
Sortorder field, enter a numerical value.

4. Inthe Template Manager or the Content Editor, hide the standard fields.

For instructions to hide the standard fields, see the section How to Show or Hide the Standard
Fields.

3.3.4 Rich Text Editor (RTE) Configuration
Rich Text Editor (RTE) profiles control the features available in the Rich Text Editor (RTE) fields.
Developers use RTE profiles:

e Toremove features from RTE fields.

e To enable default features in RTE fields.

e To expose different features to different users of RTE fields.

e To configure drop-down menus and other options in RTE fields.

e To add custom features to RTE fields.
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e To make different features available in different data templates and different RTE fields in a
single template.

Developers may reference an RTE profile using the source property of each RTE field definition item.
Sitecore stores RTE profiles under /Sitecore/System/Settings/Html Editor Profilesin
the Core database. If the developer does not define the source property for an RTE field, Sitecore
applies the /Sitecore/System/Settings/Html Editor Profiles/Rich Text Default
RTE profile.

Only the definition items that exist in each RTE profile appear in fields using that profile. Access rights
assigned to definition items in the RTE profile control access to RTE features for different users.

Tip

For consistency, accessibility, and reusability, separate design from presentation. RTE fields defeat
this purpose by merging content with styling, such as CSS styles, and presentation, such as HTML
tables and images. In addition to minimizing use of the RTE field type, minimize features available in
each RTE field using RTE profiles.

RTE Profile Definition Item Reference

The following table describes items that can appear within an RTE profile definition item.

Path Function

/Buttons/HTML View | Controls whether or not the HTML tab appears at the bottom
of the RTE.

/Class Translation | Maps styling information in content pasted into the pasted
into the RTE to corresponding CSS styles.

/Font Names Populates the font names drop-down menu.

/Font Sizes Populates the font sizes drop-down menu.

/Links Populates the Custom Links drop-down menu.

/Paragraphs Populates the elements drop-down menu.

/Ribbon Controls the formatting ribbon in the Page Editor.

/Snippets Populates the snippets feature.

/Tidy This path has been discontinued.

/Toolbar 1 Controls options on the primary toolbar.

/Toolbar 2 Controls options on the secondary toolbar.

/Toolbar 3 Controls options on the tertiary toolbar.

/WebEdit Buttons Controls formatting buttons shown beneath the field when
inline editing in the Page Editor.

/Zoom Populates the Zoom drop-down menu.

How to Configure RTE Profiles
To configure RTE Profiles:

1. Inthe Sitecore desktop in the Core database, in the Content Editor in the Core database,
selectthe /Sitecore/System/Settings/Html Editor Profiles item. For
instructions to select a database in the Sitecore desktop, see the section How to Select a
Database in the Sitecore Desktop.
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2. Inthe Sitecore desktop in the Core database, in the Content Editor, beneath each custom
RTE profile definition item, remove options that are unnecessary for all users, and control the
visibility of other options using the item: read access right.

3. Inthe Sitecore desktop, select the Master database. For instructions to select a database,
see the section How to Select a Database in the Sitecore Desktop.

Important

Do not edit the default RTE profiles under the /Sitecore/System/Settings/Html Editor
Profiles item in the Core database. Instead, duplicate an existing RTE profile, and configure RTE
data template field definition items to use that profile.

Tip

To configure the default RTE profile without editing it or specifying that profile in the Source property
of each RTE field definition, duplicate the default RTE profile to create a backup, and then edit the
original.

How to Determine the Path to an RTE Profile

To determine the path to an RTE profile:

1. Inthe Sitecore desktop in the Core database, in the Content Editor, select the RTE profile
definition item. For instructions to select a database in the Sitecore desktop, see the section
How to Select a Database in the Sitecore Desktop.

2. Inthe Sitecore desktop in the Core database, in the Content Editor, copy the path to the
RTE profile definition item to the Windows clipboard. For instructions to copy an item path to
the windows clipboard, see section How to Copy the ID or Path of an Item to the Windows
Clipboard.

3. Inthe Sitecore desktop, select the Master database. For instructions to select a database,
see the section How to Select a Database in the Sitecore Desktop.

How to Set the Profile for an RTE Template Field Definition Item
To set the RTE profile for an RTE template field definition item:
1. Inthe Template Manager or the Content Editor, select the RTE field definition item.

2. Inthe Template Manager or the Content Editor, in the Data section, in the Source field,
enter the path to the RTE profile.

How to Add Features to an RTE Profile
To add features to an RTE profile:

e Copy features from the /Sitecore/System/Settings/Html Editor Profiles/Rich
Text Full RTE profile definition.

How to Set the CSS Used by RTE Fields

To set the Csascading Style Sheet (CSS) file used to populate the Apply CSS Class drop-down in all
RTE fields:

1. Close the Rich Text Editor.

® For information about loading different CSS files into the RTE, see
http://sdn.sitecore.net/Scrapbook/Dynamically%20loading%20web%20stylesheets%20in%20RTE.asp
X.
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2. Inweb.config,inthe /configuration/sitecore/settings/setting element with
name WebStylesheet, set the value attribute to the path to a CSS file relative to the
document root of the IS Web site.

3. Open the Rich Text Editor to see the change.

How to Limit the CSS Styles Visible in RTE Fields

You can use the CSS import directive to prevent styles from appearing in the Apply CSS Class
drop-down menu in the RTE.

This Apply CSS Class drop-down includes styles defined in the CSS file specified by the value
attribute of the /configuration/sitecore/settings/setting elementin web.config with
name WebStylesheet.

Most Web sites use CSS styles that are not relevant to content in the RTE. You can use the CSS
import directive to prevent these styles from appearing in the Apply CSS Class drop-down in the
RTE.

For example, place the styles that users can apply to content in the RTE in the file
contentstyles.css, and set the WebStylesheet setting to the path to that file relative to the
document root. Place the styles that should not appear in the RTE in the file sitestyles.css inthe
same directory, and reference that file in your layouts. In sitestyles.css, import
contentstyles.css with a CSS import directive such as the following:

@import url (contentstyles.css);

Only styles defined in contentstyles.css appear in the RTE, while presentation components can
use styles defined in both sitestyles.css and contentstyles.css.

Warning
The RTE does not support the CSS import directive. Styles defined in CSS files imported by the
CSS file specified by the WebStylesheet setting in web.config will not appear in the RTE.

Warning

Due to various levels of caching, changes to CSS files may not be visible in the browser immediately.
If changes to CSS files do not appear, perform the following operations in order until the change
appears: reload the Rich Text Editor, clear the browser cache, restart 1S, and change the value of the
value attribute of the /configuration/sitecore/settings/setting elementin
web.config with name WebStylesheet.

How to Configure the RTE HTML Element Types Drop-Down Menu
To configure the HTML element types listed in the RTE:

4. Inthe Sitecore desktop in the Core database, in the Content Editor, select the RTE profile
definition item. For instructions to select a database in the Sitecore desktop, see the section
How to Select a Database in the Sitecore Desktop.

5. In the Sitecore desktop in the Core database, in the Content Editor, under the RTE profile
definition item, select /Paragraphs.

6. Inthe Sitecore desktop in the Core database, in the Content Editor, insert an HTML element
definition item using the /System/Html Editor Profiles/Html Editor List Item
data template.

7. Inthe Sitecore desktop in the Core database, in the Content Editor, select the HTML
element definition item.

8. Inthe Sitecore desktop in the Core database, in the Content Editor, in the Data section, in
the Header field, enter the value to display in the elements drop-down.
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9. Inthe Sitecore desktop in the Core database, in the Content Editor, in the new item, in the
Data section, in the Value field, enter the HTML element to insert when the user chooses this
element type.

10. In the Sitecore desktop, select the Master database. For instructions to select a database,
see the section How to Select a Database in the Sitecore Desktop.

How to Enable Snippets in an RTE Profile
To enable snippets in an RTE profile:

1. Inthe Sitecore desktop in the Core database, in the Content Editor, select the
/Sitecore/System/Settings/Html Editor Profiles/Rich Text Full/Toolbar

1 item. For instructions to select a database in the Sitecore desktop, see the section How to
Select a Database in the Sitecore Desktop.

2. Inthe Sitecore desktop in the Core database, in the Content Editor, copy the Insert
Snippet item to the corresponding location in the RTE profile.

3. Inthe Sitecore desktop, select the Master database. For instructions to select a database,
see the section How to Select a Database in the Sitecore Desktop.

How to Add a Snippet to an RTE Profile
To add a snippet to an RTE profile:

1. Inthe Sitecore desktop in the Core database, in the Content Editor, select the Snippets
item beneath the relevant RTE profile definition item within the
/Sitecore/System/Settings/Html Editor Profiles branch. For instructions to
select a database in the Sitecore desktop, see the section How to Select a Database in the
Sitecore Desktop.

2. Inthe Content Editor, with the Snippets item within the relevant RTE profile definition item
selected, insert a snippet definition item using the /System/Html Editor
Profiles/Html Editor Snippet data template.

3. Inthe Sitecore desktop in the Core database, in the Content Editor, in the snippet definition
item, in the Data section, in the Header field, enter the text to display in the snippets drop-
down list.

4. Inthe Sitecore desktop in the Core database, in the Content Editor, in the snippet definition
item, in the Data section, in the Value field, enter markup to insert when the user chooses the
shippet.

5. Inthe Sitecore desktop, select the Master database. For instructions to select a database in
the Sitecore desktop, see the section How to Select a Database in the Sitecore Desktop.

How to Control the Markup Inserted by the Enter Key

The value attribute of the /configuration/sitecore/settings/setting elementin
web.config with name HtmlEditor.LineBreak controls the markup that the Rich Text Editor
inserts when a user presses the ENTER key. By default, the value of this setting is p, causing the
Rich Text Editor to surround text with paragraph elements (“<p>...</p>"). To insert a line break
element (“<br>") at the end of the line instead of wrapping the text with paragraph elements, change
the value of this setting to br.

Note

If the value of the /configuration/sitecore/settings/setting element with name
HtmlEditor.LineBreak is p, you can insert a line break element (<br>) by pressing CTRL-
ENTER. If the value of this setting is br, you can insert paragraph elements (<p>. . .</p>) by
pressing CTRL-M.
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How to Disable the RTE HTML Tab for Some or All Users

You can remove the HTML tab from the RTE for all CMS users, or use access rights to control which
users can access the HTML tab.

To remove or restrict the HTML tab from the RTE:

1. Inthe Sitecore desktop in the Core database, in the Content Editor, select the RTE editor
profile definition item. For instructions to select a database in the Sitecore desktop, see the
section How to Select a Database in the Sitecore Desktop.

2. Inthe Sitecore desktop in the Core database, in the Content Editor, delete or restrict read
access rights to the /Buttons/HTML View item.

3. Inthe Sitecore desktop, select the Master database. For instructions to select a database in
the Sitecore desktop, see the section How to Select a Database in the Sitecore Desktop.
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3.4 Custom User Interfaces in Data Templates

If Sitecore does not provide the data template user interface elements that you need, you can
implement custom user interface in data templates.

3.41 ThelFrame Field Type

The IFrame data template field type enables developers to cause arbitrary Web applications to
appear as data template fields when working with items in the Content Editor.

Developers use the IFrame field type:
e To add simple custom field editors to data templates.
e To add reports and other custom applications to data templates.

Fields of type IFrame load the URL specified in the source property of the field definition item into an
IFrame in the Content Editor. Sitecore adds the following query string parameters to the URL:

Parameter Function

id The GUID of the item selected by the user.
la The language code selected by the user.
Vs The version number selected by the user.

Developers can pass additional variables by adding query string parameters to the URL specified in
the source property of the IFrame field definition item.

How to Create an IFrame Data Template Field
To create an IFrame data template field:

1. Inthe Visual Studio Web application project, create a web page that contains the user
interface to display in the iframe. For information about the query string parameters passed to
the IFrame field, see the section The IFrame Field Type.

2. Inthe Template Manger or the Content Editor, select the data template definition item.

3. Inthe Template Manager or the Content Editor, in the editing pane, click the Builder tab.
The Template Builder appears.

4. Inthe Template Builder, add a field of type IFrame, and then save the data template.*

In the Template Manager or the Content Editor, expand the section definition item, and then
select the IFrame data template field definition item.

6. Inthe Template Manager or the Content Editor, in the Data section, in the Source field,
enter the URL of the web page created previously containing the IFrame user interface.

3.4.2 ltem Editors

Item editors define alternate user interfaces for working with items in the Content Editor. Developers
implement custom item editors:

e To provide arbitrary applications for working with specific items or items based on specific
data templates.

* For instructions to add a field, see the Data Definition Reference manual at
http://sdn.sitecore.net/Reference/Sitecore%206/Data%20Definition%20Reference.aspx.
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e To provide summaries, reports, or other interfaces for individual items or items based on
specific data templates.

e To provide a single user interfaces to update a hierarchy of items.

Item editors appear as tabs in the Content Editor when a user selects an item. Each tab in the
Content Editor activates a different item editor. Developers can associate any number of item editors
with an item or a data template. The standard values item for each data template defines default item
editors for all items associated with that template.

The default editor for all items appears as the Content tab in the Content Editor. This interface
displays field editing controls grouped in sections as defined by the item’s data template and its base
templates.

Sitecore associates various item editors with specific types of items by default. The Folder item editor
for folders defines the Folder tab listing existing child items and options to create new child items. The
Builder item editor for data templates defines the Builder tab for working with the data template
sections and fields comprising the template.

Item editors are URL-addressable Web applications. Sitecore manages item editors under
/Sitecore/Content/Applications/Content Editor/Editors inthe Core database.

Sitecore passes the following query string parameters to item editors:

Parameter Function

id The GUID of the item selected by the user

language The language code selected by the user.

version The version number selected by the user.

database The name of the database containing the item selected by the user.

Note
You can pass additional variables by adding query string parameters in the URL specified in the Url
field in the Data section of the editor definition item.

Note
Item editors supersede the Editor property in previous versions of Sitecore.

How to Configure Item Editors
To configure item editors:

1. Inthe Template Manager or the Content Editor, select the standard values item or the
individual item.

2. Inthe Template Manager or the Content Editor, click the Configure tab.

3. Inthe Template Manager or the Content Editor, on the Configure tab, in the Appearance
group, click Editors and the Custom Editors dialog box appears.

4. Inthe Custom Editors dialog box, in the All field, expand the branches and double-click item
editors to add them to the Selected list.

5. To change the order of item editor tabs, in the custom editors dialog, in the Selected field,
select an item editor, and then click the arrows at the right to sort the selection.

6. Toremove an item editor, in the Custom Editors dialog box, in the Selected list, double-click
the item editor.
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How to Create a Custom Item Editor

To create a custom item editor:

1.

In the Visual Studio Web application project, create a web page containing the custom item
editor user interface.’

In the Sitecore desktop in the Core database, in the Content Editor, select the
/Sitecore/Content/Applications/Content Editor/Editors/Items item. For
instructions to select a database in the Sitecore desktop, see the section How to Select a
Database in the Sitecore Desktop.

In the Sitecore desktop in the Core database, in the Content Editor, insert an item editor
definition item using the /Sitecore Client/Content Editor/Editor data template.
For instructions to select a database in the Sitecore desktop, see the section How to Select a
Database in the Sitecore Desktop.

In the Sitecore desktop in the Core database, in the Content Editor, in the item editor
definition item, in the Data section, in the Header field, enter a value that Content Editor
should display in the tab that activates the item editor.

In the Sitecore desktop in the Core database, in the Content Editor, in the item editor
definition item, in the Data section, in the Icon field, enter the icon to display in the tab that
activates the item editor.

In the Sitecore desktop in the Core database, in the Content Editor, in the item editor
definition item, in the Data section, In the URL field, enter the URL of the web page created
previously containing the item editor user interface.

In the Sitecore desktop in the Core database, in the Content Editor, in the item editor
definition item, in the Data section, save the item editor definition item.

In the Sitecore desktop, select the Master database.

® For information about the query string parameters passed to the custom editor, see
http://sdn.sitecore.net/Reference/Sitecore%206/Client%20Configuration%20Reference.aspx.
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3.5 Insert Options
Insert options control the types of items users can insert beneath existing items.®
Developers apply insert options:

e To help users create appropriate types of items under existing items.

e To restrict the types of items users can create under existing items.

e To allow different users to create different types of items under existing items.

e To help users create a number of items with a single action in the user interface.

e To create items programmatically, for example, by invoking a wizard.

® For more information about insert options, see the Data Definition Reference manual at
http://sdn.sitecore.net/Reference/Sitecore%206/Data%20Definition%20Reference.aspx and the Data
Definition Cookbook at
http://sdn.sitecore.net/Reference/Sitecore%206/Data%20Definition%20Cookbook.aspx.
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Data Validation

This chapter provides procedures to configure data validation. Developers use data validation to
enforce rules for data entry. This chapter contains the following sections:

e Validation Overview

e Types of Validation

e Validation Error Levels

e Configuring Validation Rules
e Registering Validators

e Custom Validators

e Validation Actions
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4.1 Validation Overview
You can configure data validation to control how Sitecore handles invalid data.

You can configure Sitecore to invoke validation rules in the Quick Action Bar, in the Validator Bar,
when the user chooses the Validate command in the Proofing group on the Review tab, and when the
user chooses a specific workflow command.

Note
In general, select the same validation rules for all four types of validation.

You can configure different validators to for each data template field, for all data template fields of a
data template field type, for individual items, for all items based on a data template, and for all items.

Important

For each item, Sitecore invokes the item validation rules defined in the item or the standard values
item associated with its data template, as well as global validation rules. For each data template field,
Sitecore invokes the validation rules defined in the data template field definition item, as well as the
validation rules defined in the data template field type validation rules definition item. The number of
validators that the system must invoke for an item affects the server resources used and can affect
client performance.

Important

Do not edit the default validator definition items under
/sitecore/system/Settings/Validation Rules. Instead, register additional validators by
creating additional validator definition items.

Note

After you stop editing a field value, Sitecore automatically invokes validation rules asynchronously,
and then updates the user interface after validation completes. The value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
Validators.UpdateDelay controls the length of time between the cessation of editing activity and
the invocation of the validators. To disable this automatic revalidation feature, set the value attribute
of the /configuration/sitecore/settings/setting elementin web.config with name
Validators.AutomaticUpdate to False.

Note
The default Sitecore configuration disables validation in the Quick Action Bar. To enable Quick Action
Bar validation, right-click the Quick Action Bar, and then select Validation Rules.

Tip

Avoid use of the Validation and Validation Text fields in the Data section of field definition items
available in earlier versions of Sitecore in favor of the data validation features described in this
document.
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4.2 Types of Validation

You can validate various types of data.

4.2.1 Data Template Field Validation

You can configure Sitecore to validate the contents of each field in each data template.

4.2.2 Field Type Validation

You can configure Sitecore to validate the contents of each of the different field types.

423 ltem Validation

You can configure validation for individual items.

424 Standard Validation

You can configure validation for all items based on a data template by configuring validation rules in
the standard values of that data template.

425 Global Item Validation

You can configure validation that applies to all items.
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4.3 Validation Error Levels

Validation error levels control the actions Sitecore takes on validation results. Each validator returns
one of the following error levels defined in Sitecore.Data.Validators.ValidatorResult.

Error Level Ul Color | Function

Unknown Gray Validation incomplete or result otherwise unknown.

Valid Green Valid.

Suggestion Green Suggestions appear in the user interface.

Warning Orange Warnings appear in the user interface.

Error Red Errors prevent the user from completing workflow
commands associated with the workflow validation
action.

CriticalError | Red Critical errors cause a modal warning when the user
attempts to save an item and prevent the user from
completing workflow commands associated with the
workflow validation action.

FatalError Red Fatal errors cause a modal warning and prevent the
user from saving the item.
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4.4 Configuring Validation Rules

You can configure Sitecore to invoke validation rules in the Quick Action Bar, in the Validator Bar,
when the user chooses the Validate command in the Proofing group on the Review tab, and when the
user chooses a specific workflow command.

44.1 How to Configure Quick Action Bar Validation Rules
To configure validation rules to invoke in the Quick Action Bar:

1. Inthe Content Editor, select the appropriate validation rules definition item as described in
the following sections.

2. Inthe Content Editor, in the Validation section, in the Quick Action Bar field, select
validation rules.

4.4.2 How to Configure Validate Button Validation Rules

To configure validation rules to invoke when the user clicks the Validate command in the Proofing
group on the Review tab:

1. Inthe Content Editor, select the appropriate validation rules definition item as described in
the following sections.

2. Inthe Content Editor, in the Validation section, in the Validate Button field, select
validation rules.

4.4.3 How to Configure Validation Bar Validation Rules
To configure validation rules to invoke in the Validation Bar:

1. Inthe Content Editor, select the appropriate validation rules definition item as described in
the following sections.

2. Inthe Content Editor, in the Validation section, in the Validation Bar field, select validation
rules.

Note

The validation bar does not appear in Content Editor if the value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
ContentEditor.ShowValidatorBar is false.

444 How to Configure Workflow Validation Rules
To configure validation rules to invoke when the user chooses a workflow command:

1. Inthe Content Editor, select the appropriate validation rules definition item as described in
the following sections.

2. Inthe Content Editor, in the Validation section, in the Workflow field, select validation rules.

445 How to Create a Workflow Command or State Validation Action

To configure Sitecore to invoke the validation workflow action when the user chooses a workflow
command or when the user chooses a workflow command:

1. Inthe Content Editor, select the workflow state or command.

2. Inthe Content Editor, insert a validation workflow action definition item using the
/System/Workflow/Validation Action datatemplate.
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3. Inthe Content Editor, in the validation workflow action, in the Data section, in the Type field,
enter the following:

Sitecore.Workflows.Simple.ValidatorsAction, Sitecore.Kernel.

4. Inthe Content Editor, in the validation workflow action, in the Data section, in the Max
Result Allowed field, enter the maximum
Sitecore.Data.Validators.ValidatorResult value the workflow validation action
can generate. If validation generates a higher validation error level, the workflow validation
action will prevent the user from completing the workflow command. The default value for this
field is Warning.

5. Inthe Content Editor, in the validation workflow action, in the Data section, in the Unkown
Result field, enter a message to display to the user if the validator returns Unknown as the
validation result.

6. Inthe Content Editor, in the validation workflow action, in the Data section, in the Warning
Result field, enter a message to display to the user if the validator returns Warning as the
validation result.

7. Inthe Content Editor, in the validation workflow action, in the Data section, in the Error
Result field, enter a message to display to the user if the validator returns Error as the
validation result.

8. Inthe Content Editor, in the validation workflow action, in the Data section, in the Critical
Error Result field, enter a message to display to the user if the validator returns
CriticalError as the validation result.

9. Inthe Content Editor, in the validation workflow action, in the Data section, in the Fatal
Error Result field, enter a message to display to the user if the validator returns
FatalError as the validation result.

4.4.6 How to Configure Validation Rules for All Instances of a Data
Template Field Type

To configure validation rules to invoke for all instances of a specific data template field type:

1. Inthe Content Editor, selectthe /Sitecore/System/Settings/Validation
Rules/Field Types item.

2. Inthe Content Editor, select the existing data template field type validation rules definition
item, or insert a data template field type validation rules definition item using the
/System/Validation/Field Type Validation Rules data template. For the name
of the field type validation definition item, use the name of the field type as it appears in the
Type field in the Data section of the field type definition item.

3. Inthe Content Editor, in the data template field type validation rules definition item, in the
Validation Rules section, configure validation rules.

447 How to Configure Validation Rules for All Items:
To configure validation rules for all items:

¢ Inthe Content Editor, selectthe /Sitecore/System/Settings/Validation
Rules/Global Rules item, and then configure validation rules.

4.4.8 How to Configure Validation Rules for an Individual Item or All
Items Based on a Specific Data Template

To configure validation rules for an individual item or all items based on a specific data template:
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1. Inthe Template Manager or the Content Editor, show the standard fields. For instructions to
show the standard fields, see section How to Show or Hide the Standard Fields.

2. Inthe Template Manager or the Content Editor, select standard values item for the data
template, or select the individual item.

In the Template Manager or the Content Editor, configure validation rules.

4. Inthe Template Manager or the Content Editor, hide the standard fields. For instructions to
hide the standard fields, see section How to Show or Hide the Standard Fields.

449 How to Configure Validation Rules for a Specific Data Template
Field
To configure validation rules for a specific data template field:

1. Inthe Template Manager or the Content Editor, select the data template field definition
item.

2. Inthe Template Manager or the Content Editor, in the Validation Rules section, configure
field validation rules.

4410 Default ltem Validors

You can configure item validation rules using the following default validators.

Validator Function
Broken Links Identifies invalid references.
Duplicate Name Identifies items with a name or display name that matches

the name or display name of another item under the same
parent (case-insensitive).

Full Page XHtml Checks the validity of the output of requesting the item using
the default device.

Media Size Too Big Identifies media too large to serialize for database storage.

Url Characters Checks item names for characters requiring escape

sequences in URLSs.

Note

XHTML validators validate the XML against the schema defined by the value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
XHtmlSchemaFile.

4.4.11 Default Field Validators

You can configure field validation rules using the following default validators.

Validator Function

Broken Links Identifies invalid references.

Is Email Identifies invalid email addresses.

Is Integer Identifies invalid integers.

Is XHtml Checks validity of field against local XHTML schema.
Max Length 40 Identifies field values containing more than 40 characters.
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Validator Function

Rating 1 to 9 Identifies invalid integers, negative numbers, and values
greater than nine.

Required Identifies empty fields.

Spellcheck Identifies fields containing spelling errors.

W3C XHtml Validation | Identifies invalidity against remote W3C validation service.

Alt Required Identifies missing Alt text in media library image data

templates.

Extension May Not
Start with a Dot

Identifies media items with a dot character in the field named
extension, which is invalid.

External Link Target

Identifies external links in Rich Text Editor fields that should
open in a new browser window and provide a title.

Image Has Alt Text

Identifies image fields that do not contain alternate text and
that reference media items that do not contain alternate text.

Image Has Alt Text
from Media Library

Identifies image fields that do not specify alternate text and
that reference media items that do contains alternate text.

Image Size

Identifies image field that references a media item that
exceeds the size limit.

Rich Text Image Size

The width of images used in the Rich Text Editor must not
exceed the value of the
/configuration/sitecore/settings/setting
element in web.config with name
Media.MaxImageWidth.

Note

The value attribute of the /configuration/sitecore/settings/setting elementin
web.config With name HtmlEditor.ValidatorServiceUrl controls the URL used for W3C
XHtml Validation.
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4.5 Registering Validators

You can configure validation rules definition items to use the default validators, or register custom
validators.

Important

To maximize the performance of the Sitecore user interfaces, validators that consume significant
resources and especially processing time, such as to invoke external services or other potentially
long-running operations, should run in separate threads. Using a separate thread allows the system to
invoke additional validators before a validator completes. Sitecore will update the user interface as the
different validators complete.

45.1 How to Register a Validator
To register a field validator:

1. Inthe Content Editor, select the appropriate project-specific folder under the
/Sitecore/System/Settings/Validation Rules/Field Rules item or the
/Sitecore/System/Settings/Validation Rules/Item Rules item.

2. Inthe Content Editor, insert a validator definition item using the
/System/Validation/Validation Rule datatemplate.

3. Inthe Content Editor, in the validator definition item, in the Data section, in the Type field,
enter the class signature.

4. Inthe Content Editor, in the validator definition item, in the Data section, in the Parameters
field, enter URL-escaped key=value parameters, separated by ampersand characters (“&”).

5. If the validator should run in a separate thread, then in the Content Editor, in the validator
definition item, in the Data section, select Use Thread.

45.2 How to Register a Regular Expression Field Validator
To register a regular expression field validator:

1. Register the field validator. For instructions to register a validator, see the section How to
Register a Validator.

2. Inthe Content Editor, in the validator definition item, in the Data section, in the Type field,
enter the following .NET type signature:

Sitecore.Data.Validators.FieldValidators.RegexValidator,Sitecore.Kern
el

3. Inthe Content Editor, in the validator definition item, in the Data section, in the Parameters
field, enter the following:

Pattern=RegularExpression&Text=Message

4. Inthe Content Editor, in the validator definition item, in the Data section, in the Parameters
field, replace RegularExpression with a regular expression.

5. Inthe Content Editor, in the validator definition item, in the Data section, in the Parameters
field, replace Message with a message to display if the field does not match the pattern.
Sitecore will call String.Format () to substitute {0} in the message with the name of the
field.
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45.3 How to Register an Integer Field Validator
To register an integer field validator:

1. Register the field validator. For instructions to register a validator, see the section How to
Register a Validator.

2. Inthe Content Editor, in the validator definition item, in the Data section, in the Type field,
enter the following .NET type signature:

Sitecore.Data.Validators.FieldValidators.IntegerFieldValidator, Sitecore.Kernel

3. Inthe Content Editor, in the validator definition item, in the Data section, in the Parameters
field, enter the following:

AllowNegative=AllowNegative=Boolean&AllowZero=Boolean

4. Inthe Content Editor, in the validator definition item, in the Data section, in the Parameters
field, replace Boolean with True or False as appropriate.

45.4 How to Register an Integer Range Field Validator
To register an integer field range validator:

1. Register the field validator. For instructions to register a validator, see the section How to
Register a Validator.

2. Inthe Content Editor, select the validator definition item.

3. Inthe Content Editor, in the Data section, in the Type field, enter the following .NET type
signature:

Sitecore.Data.Validators.FieldValidators.IntegerRangeValidator, Sitecore.Kernel
4. Inthe Content Editor, in the Data section, in the Parameters field, enter the following:

Min=Minumumé&Max=Maximum

5. Inthe Content Editor, in the Data section, in the Parameters field, replace Minimum with the
minimum allowed value for the field.

6. Inthe Content Editor, in the Data section, in the Parameters field, replace Maximum with
maximum allowed value for the field.

455 How to Register a Maximum Length Field Validtor
To register a maximum field length validator:

1. Register the field validator. For instructions to register a validator, see the section How to
Register a Validator.

2. Inthe Content Editor, select the validator definition item.

3. Inthe Content Editor, in the Data section, in the Type field, enter the following:

Sitecore.Data.Validators.FieldValidators.MaxLengthFieldValidator, Sitecore.Kernel

4. Inthe Content Editor, in the Data section, in the Parameters field, enter the following:

MaxLength=MaximumLength

5. Inthe Content Editor, in the Parameters field, replace MaximumLength with the maximum
allowed length of the field value.

45.6 How to Register Validators for Specific Iltems and Items Based
on Specific Templates

To register validation rules for specific items and items based on specific templates:
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4.5.7

In the Content Editor, selectthe /Sitecore/System/Settings/Validation
Rules/Item Rules item.

In the Content Editor, insert a validation rule definition item using the
/System/Validation/Validation Rule datatemplate.

In the Content Editor, select the validation rule definition item.
In the Content Editor, in the Data section, in the Type field, enter the class signature.

In the Content Editor, in the validation rule definition item, in the Data section, in the
Parameters field, enter URL-escaped key=value parameters, separated by ampersand
characters (“&”").

How to Disable Default Validation Rules

To disable default validation rules for all items:

1. Inthe Content Editor, select the /Sitecore/System/Settings/Validation
Rules/Global Rules item.

2. Inthe Content Editor, in the Validation Rules section, configure validation rules.

3. Inthe Content Editor, selectthe /Sitecore/System/Settings/Validation
Rules/Field Types item.

4. Inthe Content Editor, configure validation in field type validation rules definition items.

In the Content Editor, select the /Sitecore/Templates/System/Media item.

6. Inthe Template Manager or the Content Editor, show the standard fields. For instructions to
show the standard fields, see the section How to Show or Hide the Standard Fields.

7. For each of the data templates used for media, in the Template Manager or the Content
Editor, select the data template definition item, then click the Content tab in the editing pane,
and then in the Validation Rules section, configure validation.

8. Inthe Template Manger or the Content Editor, hide the standard fields. For instructions to
hide the standard fields, see the section How to Show or Hide the Standard Fields.

Important

No character in an item name can match the regular expression specified by the value attribute of
the /configuration/sitecore/settings/setting elementin web.config with name
InvalidItemNameChars. An item name must match the regular expression specified by the value
attribute of the /configuration/sitecore/settings/setting elementin web.config with
name ItemNameValidation. Do not change these two settings.

4.5.8

How to Override the Default Error Level for a Validator

To override the default error level for a validator:

1.
2.

In the Content Editor, select the validator definition item.
In the Content Editor, in the Data section, in the Parameters field, enter the following:
Result=ErrorLevel

In the Content Editor, in the Data section, in the Parameters field, replace ErrorLevel
with the name of the error level in Sitecore.Data.Validators.ValidatorResult.
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4.6 Custom Validators

This section describes procedures to implement a custom validator.

4.6.1 How to Implement a Custom Validator

A custom validator involves two components: a .NET class and a validator definition item.

4.6.2 How to Implement a Custom Validator
To implement a custom validator:

1. Inthe Microsoft Visual Studio Web application project, create a class based on the following
prototype:

using System.Runtime.Serialization;
using Sitecore.Data.Validators;

namespace Namespace.Data.Validators.ItemValidators//TODO:namespace (Fieldvalidators)
{
[Serializable]
public class ClassName : Sitecore.Data.Validators.StandardvValidator
{
public ClassName () {}//TODO:class name

public ClassName (

SerializationInfo info, StreamingContext context) :base(info, context)
{
}

public override string Name
{
get
{
return (GetType () .ToString());//TODO:validator name

}
}

protected override ValidatorResult GetMaxValidatorResult ()

{
return (GetFailedResult (ValidatorResult.Error));//TODO:error level

}

protected override ValidatorResult Evaluate ()

{
if (false)//TODO:validate ControlValidationValue

{
return (ValidatorResult.Valid) ;

}

else

{
Text = "error message";//TODO:error message
return (GetFailedResult (ValidatorResult.Error));//TODO:error level
}
}

2. Inthe class, replace Namespace.Data.ItemValidators with the appropriate
namespace.

3. Inthe class, replace all instances of ClassName with the class name.
4. Inthe class, replace GetType () . ToString () with the friendly name of the validator.

In the class, replace all instances of with the appropriate validation error level.
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6. Inthe class, replace false with logic to validate the field value in
ControlValidationValue or the item returned by GetItem().

7. Inthe class, replace error message with an error message.

8. Register the validator. For instructions to register a validtor, see the section How to Register a
Validator.

Important

If the result of the GetMaxValidatorResult () method is FatalError of CriticalError, then
Sitecore will block operations such as save or workflow commands in the user interface as
appropriate until validation completes. To avoid blocking user interface actions during validation, the
GetMaxValidtorResult () method of expensive validators should not return FatalError or
CriticalError. Validation Bar and Quick Action Bar validators never block user interface

operations.
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4.7 Validation Actions

Validation actions represent clickable operations in the user interface to correct validation errors.

4.7.1 How to Create a Validation Action
To create a validation action for a Single-Line Text data template field:

1. Inthe Visual Studio Web application project, create a class based on the following prototype:

using Sitecore.Shell.Framework.Commands.ContentEditor.Validators;

namespace Namespace.Shell.Framework.Commands.ContentEditor.Validators//TODO:namespace
{ public class ClassName:ValidatorCommand//TODO:class name
{ public override void Execute (CommandContext context)
{ var validator=GetValidator (context) ;
if (validator!=null)

{

var control = GetControlToValidate (validator);
if (control!= null)
{
control = control as Sitecore.Web.UI.HtmlControls.Control;

if (control!=null)

{
control.Value=Value;//TODO:logic
Validate () ;

2. Inthe class, replace
Namespace.Shell.Framework.Commands.ContentEditor.Validators with the
namespace of the class.

3. Inthe class, replace ClassName with the name of the class.
4. Inthe class, replace value with the validated value for the field.

5. Inthe Content Editor, selectthe /Sitecore/System/Settings/Validation
rules/Field Rules item.

6. Inthe Content Editor, insert a validation action definition item using the
/System/Menus/Menu Item data template.

7. Inthe Content Editor, in the validation action definition item, in the Data section, in the
Display Name field, enter the label the user should select in the user interface to invoke the
validation action.

8. Inthe /App Config/commands.config file, insert a new command based on the following
prototype:

<command name="validator:ClassName" type="Namespace.Class,Assembly"/>

9. Inthe /App Config/commands.config file, replace ClassName with the name of the
class, and then replace Namespace.Class, Assembly with the namespace and the class
signature.

Important

Because unsaved values are only available in the Ul and not in the database, you cannot use
Sitecore.Data.Items.Item and other APIs in validation actions. The API used to validate fields
depends on the field type, and may involve JavaScript, such as for values of Rich Text Editor fields.
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4.7.2 How to Use a Validation Action
To use a validation action:

1. Inthe Content Editor, edit an item that violates a validation rule that provides a validation
action.

2. Inthe Validation Bar, right-click the validation indicator, and then select the validation action.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 42 of 62



Sitecore CMS 6.2 Client Configuration Cookbook @ S|teco re

The Page Editor

This chapter provides describes provides procedures to configure the Page Editor,
which provides CMS features such as inline editing and the design pane.

This chapter contains the following sections:
e Page Editor Overview
e Placeholder Settings
e Page Editor Modes
e Edit Frames

e The Field Editor
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5.1 Page Editor Overview

As a user navigates the Web site, the Page Editor superimposes user interface elements that contain
editing functions on the items the user selects.

5.1.1 The Design Pane of the Page Editor

In the Page Editor, you can use the Design pane to configure layout details for content items. The
Design pane prevents users from binding presentation components other than those expressly
allowed using Placeholder Settings.

Note

The Design pane enforces component nesting order, prevents users from attempting to bind
presentation components to placeholders that do not exist, and inserts fully-qualified placeholder
keys.
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5.2 Placeholder Settings

Placeholder settings control which presentation components users can bind to placeholders in the
Design pane in the Page Editor. For more information about the Design pane of the Page Editor, see
the section The Design Pane of the Page Editor.

Developers use placeholder settings:
e To help users choose appropriate presentation components to bind to placeholders.

e To prevent certain users from binding components to specific placeholders.

Layout details reference placeholders either by placeholder key, or by fully qualified placeholder key.’
For example, the fully qualified placeholder key for a placeholder with key content in a sublayout
bound to a placeholder with key main in a layout would be /main/content.

Note
The Design Pane of Page Editor uses fully qualified placeholder keys, but layout details do not require
fully qualified placeholder keys.

Placeholder settings definition items with names matching placeholder keys automatically apply to
those placeholders unless layout details specify placeholder settings. The placeholder settings
definition item named content automatically applies to all placeholders with the key content,
including nested placeholders, except where layout details specify placeholder settings. For the name
of the default placeholder settings definition item for a placeholder, use the placeholder key. For
example, for the placeholder with key content, edit the placeholder settings definition item named
content. Alternatively, by convention, use the fully qualified placeholder key, replacing slash
characters (“/”) with dash characters (“-”"). For example, to control the placeholder with key content
in a sublayout intended bound to a placeholder with key main in a layout, insert a placeholder
settings definition item named content, or insert a placeholder settings definition item named main-
content and associate this placeholder settings definition item with the fully qualified placeholder
key /main/content in layout details.

Developers configure placeholder settings using placeholder setting definition items. Developers can
control the icon displayed for each placeholder by assigning an icon to each placeholder settings
definition item. Developers can restrict which users can bind presentation components to a
placeholder by denying write access to the placeholder settings definition item. Developers can enter
HTML in the Description field of the placeholder settings definition item to control the tooltip that
appears when a user moves the mouse over the placeholder in the Design pane in the Page Editor.

Important

Sitecore does not automatically apply placeholder settings using fully qualified placeholder keys to the
corresponding nested placeholders. For example, for the placeholder with fully qualified key
/main/content, if it exists, the placeholder settings definition item with name content applies, but
the placeholder settings definition item with name main-content does not. To cause different uses
of placeholders to apply different placeholder settings definition items, configure placeholder settings
for placeholder keys or fully qualified placeholder keys using layout details.

5.2.1 How to Create a Placeholder Settings Definition Iltem
To create a placeholder settings definition item:

1. Inthe Content Editor, select the /Sitecore/Layout/Placeholder Settings item.

" For more information about layout details and placeholders, see the Presentation Component
Reference manual at
http://sdn.sitecore.net/Reference/Sitecore%206/Presentation%20Component%20Reference.aspx.
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5.2.2

In the Content Editor, insert a placeholder settings definition item using the
System/Layout/Placeholder data template. Name the placeholder settings definition
item after the key of the placeholder that it controls.

In the Content Editor, select the placeholder settings definition item.

In the Content Editor, in the Data section, in the Allowed Renderings field, select the
presentation components users can bind to the placeholder.

In the Content Editor, in the Data section, in the Description field, enter a summary of the
placeholder. Consider including a graphic indicating the location of the placeholder within the
layout or sublayout.

In the Content Editor, set the icon for the placeholder settings definition item to control the
image that appears next to the name of the placeholder in the design pane of the Page Editor.
For instructions to set the icon for an item, see the section How to Set the Icon for an Item.

To control which users can bind sublayout and renderings to the placeholder, configure write
access rights for the placeholder settings definition item.

How to Configure Placeholder Settings for a Data Template or an
Individual Item

To configure placeholder settings for a data template or an individual item:

1.

In the Template Manager or the Content Editor, select the standard values item or the
individual item.

In the Template Manager or the Content Editor, click the Presentation tab.

In the Template Manager or the Content Editor, on the Presentation tab, in the Layout
group, click the Details command. The Layout Details dialog appears.

In the Layout Details dialog, under the appropriate device, click Edit. The Device Editor
appears.

In the Device Editor, click the Placeholder Settings tab, and then click Add. The
Placeholder Settings dialog appears.

In the Placeholder Settings dialog, for Key, enter the placeholder key or fully qualified
placeholder key.

In the Placeholder Settings dialog, for Settings Item, click Browse, and then select the
placeholder settings definition item.
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5.3 Page Editor Modes

Each presentation component executes in a logical page mode depending on the user actions that
caused Sitecore to invoke the component.

The modes in which a presentation component may execute include:
e The published Web site.
e The browser-based debugger (with or without profiling and tracing active).
e Page Editor (with or without inline editing active).
e Preview.
e The Design pane of the Page Editor.

e WebEdit classic mode.

Presentation components can generate different output in different modes. For example, a
presentation component may populate the HTML <title> element with the value of a field. The
browser cannot provide inline editing facilities for the HTML <title> element. If the page does not
use that field elsewhere, then the user cannot edit the field in the Page Editor. In this case, a
presentation component used elsewhere on the page can output the value of the field elsewhere on
the page if the user is inline editing. As another example, consider a rendering that should not output
a <div> element if a field value is empty. To provide inline editing for the field, the rendering can
output the <div> and the field editing control if the field has a value or if the user is in inline editing in
the Page Editor.

5.3.1 How to Determine the Page Editor Mode

You can determine the Page Editor mode using the sc:pageMode () XSL extension function or
properties of the Sitecore.Context.PageMode .NET object. For more information about the
sc:pageMode () XSL extension function and the Sitecore.Context.PageMode .NET object, see
the section Page Editor Modes.

For example, the following XSL code determines if the XSL rendering is running in any mode of the
Page Editor, as opposed to the published site:
<xsl:if test="sc:pageMode () /pageEditor">
<!-- the user is in the Page Editor. -->
</xsl:if>
The following C# code determines if the .NET component is running in the context of any mode of the
Page Editor, as opposed to the published site:

if (Sitecore.Context.PageMode.IsPageEditor)
{

// the user is in the page editor.

}

Note
The user can access multiple modes of the Page Editor simultaneously.

5.3.2 Page Editor Modes

The following table lists the XSL and .NET programming constructs to determine the page mode:

XSL .NET Description of
sc:pageMode () Sitecore.Context.PageMode | Mode

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 47 of 62



Sitecore CMS 6.2 Client Configuration Cookbook

@ Sitecore

XSL .NET Description of
sc:pageMode () Sitecore.Context.PageMode | Mode
/pageEditor IsPageEditor Accessing the Page
Editor.
/pageEditor/classic IsPageEditorClassic Using Sitecore 5
classic mode with
content markers.
/pageEditor/design IsPageEditorDesigning Using the Design
pane of the Page
Editor.
/pageEditor/edit IsPageEditorEditing Inline editing in the
Page Editor.
/pageEditor/navigate | IsPageEditorNavigating Navigating in the
Page Editor but not
inline editing.
/preview IsPreview Previewing.
/normal IsNormal Published Web site.
/profile IsProfiling Debugging and
profiling.
/debug IsDebugging Debugging.
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54 Edit Frames

Edit frames provide insert borders with context menus around markup structures when the user edits
inline in the Page Editor. Edit frame commands activate Sitecore user interface commands.® An edit
frame generates a <div> element with an edit frame menu above it. Each edit frame command in the
menu activates a Sitecore command.

12 Wekome to Stecore WdowsInteret Explorer aloix|
— ElE B 5 -
Favertes g vvecome 1 e | Y-8 - fwee G Tk -
en. | e ko] | O p v B
©
Sitecore
Welcome to Sitecore
—r—
D) et R
Besiom |

The Buttons property of the edit frame control specifies an item in the Core database that contains
children representing the edit frame menu items to expose in the edit frame menu. If you do not
specify an edit frame menu, Sitecore uses the default edit frame menu defined by the
/Sitecore/Content/Applications/WebEdit/Edit Frame Buttons/Default. This default
edit frame menu contains the Insert edit frame menu command that allows the user to insert an item
using the insert options defined for the data source of the edit frame.

A sitecore -- Webpage Dialog x|
fan  Insert
Select the item that you want to insert. You must give the item a name.
[£) sample Item
J Folder
Ttem Name: [test
Insert Cancel

For an example of implementing an edit frame, including a custom edit frame command, see the
section How to Implement a Custom Field Editor.

Note

You can configure the default edit frame menu by setting the value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
WebEdit.DefaultButtonPath.

Note

Sitecore does not support nested edit frames. An edit frame can contain any other controls, including
the FieIgRenderer Web control that generates inline editing controls, but cannot contain other edit
frames.

® For an example that uses an edit frame to open the field editor, see
http://trac.sitecore.net/DefaultFieldEditor/.

° For more information about the FieldRenderer Web control, see the Presentation Component
Reference manual at
http://sdn.sitecore.net/Reference/Sitecore%206/Presentation%20Component%20Reference.aspx.
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541 How to Implement an Edit Frame Menu Command
To implement an edit frame menu command:

1. Inthe Visual Studio Web application project, create an edit frame menu command class that
inherits from Sitecore.Shell.Applications.WebEdit.Commands.WebEditCommand.

2. Inthe class, implement the Execute () method.

3. Add an edit frame menu command definition item to an edit frame menu. For more
information, see the section How to Define an Edit Frame Menu.

54.2 How to Define an Edit Frame Menu
To define an edit frame menu:

1. Inthe Sitecore desktop in the Core database, Content Editor, select the
/Sitecore/Content/Applications/WebEdit/Edit Frame Buttons item. For
instructions to select a database in the Sitecore desktop, see the section How to Select a
Database in the Sitecore Desktop.

2. Inthe Content Editor, insert an edit frame menu definition item using the
/System/WebEdit/Edit Frame Button Folder data template.

Tip
Alternatively, you can duplicate the /Sitecore/Content/Applications/WebEdit/Edit
Frame Buttons/Default edit frame menu definition.

3. Inthe Content Editor, beneath the edit frame menu definition item, insert one or more edit
frame menu command definition items using the /System/WebEdit/Edit Frame Small
Button data template.

Tip
You can duplicate the /Sitecore/Content/Applications/WebEdit/Edit Frame
Buttons/Default/Insert item to create your edit frame menu definition item.

Tip
You can duplicate an existing edit frame menu command definition item and then update its
properties.

Tip
To insert the default field editor edit frame menu command, see the section How to Use the Default
Field Editor.

4. Inthe Content Editor, in each edit frame menu command definition item, in the Data section,
in the Header field, enter the menu label that should appear in the Page Editor for the menu
command.

5. Inthe Content Editor, in each edit frame menu command definition item, in the Data section,
set the Icon field to an icon for the menu item.
Tip
You can also use this icon for the edit frame menu command definition item itself.°

6. Inthe Content Editor, in each edit frame menu command definition item, in the Data section,
set the Click field to the Ul command the menu command invokes.

1% For instructions to set the icon for an item, see
http://sdn.sitecore.net/reference/sitecore%206/client%20configuration%20cookbook.aspx.
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7. Inthe Content Editor, in each edit frame menu command definition item, in the Data section,
set the Tooltip field to hover text for the menu item, and then save the edit frame menu
command definition item.

8. In the Sitecore desktop, select the Master database. For instructions to select a database,
see the section How to Select a Database in the Sitecore Desktop.

5.4.3 How to Insert an Edit Frame in a Layout or Sublayout

To insert an edit frame into a layout or sublayout, add code such as the following:

<sc:editframe runat="server">
</sc:editframe>

You can set properties of the edit frame as described in the section Edit Frame Properties.

5.4.4 How to Insert an Edit Frame in an XSL Rendering

To insert an edit frame into an XSL rendering, add code such as the following:

<sc:editFrame>
</sc:editFrame>

You can set properties of the edit frame as described in the section Edit Frame Properties.

5.45 Edit Frame Properties

You can set the following properties of an edit frame:

Property (.NET) Attribute (XSL) Description

Buttons Buttons Edit frame menu items
define available
commands.

CssClass class Value for class attribute of
<div> element generated
by edit frame.

DataSource select The item to pass to edit

frame menu commands.

Debug debug Controls whether Sitecore
styles the <div> element
generated by the edit
frame.

FramePadding frame-padding Expand visible edit frame
around contents by number
of pixels indicated.

HintOffset hint-offset Pixels between edit frame
hovering menu and edit
frame region.

Style style Value for style attribute of
<div> element generated
by edit frame.

Title title Title of edit frame menu.

Tooltip Tooltip Tooltip for edit frame menu.
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55 The Field Editor

The field editor provides an interface within the Page Editor that allows the user to edit fields for which
the Page Editor does not provide inline editing controls. The field editor user interface is highly
streamlined in comparison to the Content Editor user interface.
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You can configure edit frame commands to activate the field editor. Sitecore provides an edit frame
command that you can use to activate the field editor to edit the fields that you specify. You can
activate the field editor from within the Page Editor to edit fields that do not provide inline editing
controls, or to edit fields from more than one item simultaneously.** For more information about edit
frames, see section Edit Frames.

Warning
The field editor does not enforce item validation.

55.1 How to Use the Default Field Editor
The default field editor includes the fields that you specify.
To use the default field editor:

1. Define a field editor menu. For instructions to define a field editor menu, see the section How
to Define an Edit Frame Menu.

2. Inthe Content Editor, beneath the field editor menu definition item, insert the default field
editor command definition item using the System/WebEdit/Field Editor Button data
template.

Note
This field editor command definition item invokes the webedit:fieldeditor command.

3. Inthe Content Editor, in the default field editor command definition item, in the Data section,
in the Header field, enter Edit Item.

4. Inthe Content Editor, in the default field editor command definition item, in the Data section,
set the Icon field to people/16x16/cubes blue.png. Forinstructions to set the icon for
an item, see the section How to Set the Icon for an ltem.

" For an example that provides an edit frame menu command to open the field editor including all
fields in the item that are not defined in the standard template and do not support inline editing, see
http://trac.sitecore.net/DefaultFieldEditor/.
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Tip
You can also use this icon for the edit frame menu command definition item itself.

5. Inthe Content Editor, in the default field editor command definition item, in the Data section,
in the Fields field, enter the names or IDs of the fields to include in the field editor, separated
by a pipe character (“|”).

Note
Field names are not case-sensitive.

Note
If any of the specified fields do not exist, Sitecore does not generate an error.

6. Inthe Sitecore desktop, select the Master database. For instructions to select a database,
see the section How to Select a Database in the Sitecore Desktop.

5.5.2 How to Implement a Custom Field Editor
To implement a field editor that includes fields dynamically:

1. Inthe Visual Studio Web application project, create a class that inherits from the
Sitecore.Shell.Applications.WebEdit.Commands.FieldEditorCommand class.

2. Inthe class, implement the GetOptions () method to create a list of fields to include in the
field editor.

3. Inthe GetOptions () method, pass the list of fields to the constructor for the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions class.

4. Inthe GetOptions () method, set additional properties of the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions object.

5. Inthe GetOptions () method, return the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions object.

6. Add the field editor command to the appropriate edit frame menu definition. For instructions to
add a command to an edit frame menu definition item, see the section How to Define an Edit
Frame Menu.

7. Configure an edit frame in a layout, sublayout, or XSL rendering to use the edit frame menu.
For instructions to configure a layout, sublayout, or XSL rendering to use the edit frame menu,
see the section How to Insert an Edit Frame in a Layout or Sublayout or How to Insert an Edit
Frame in an XSL Rendering.

Note

The field editor merges all fields into a single visual section. You can set the Title and Icon
properties of the Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions
object to control the icon label used for this section. Alternatively, set the PreserveSections
property to true to retain the original section structure.

Note

You can set the DialogTitle property of the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions objectto control
the title of the field editor browser window.
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Security Based Configuration Features

This chapter describes the security features developers can use to optimize the user
experience of content authors, including the Sitecore security roles.

This chapter contains the following sections:
e Sitecore Client Security Roles
e Security Presets

e Data Template Field Security
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6.1 Sitecore Client Security Roles

Security administrators associate CMS users with one or more Sitecore client security roles to control
the features available through the Sitecore user interfaces.

Sitecore applications do not expose every feature to every user. Limiting available features provides a
number of benefits, including:

e Reducing the number of user interface elements improves performance and usability.
e Eliminating options prevents users from activating features inadvertently.

e Hiding unnecessary features minimizes training requirements.

A list of the specific features associated with each of the Sitecore roles is beyond the scope of this
document.

The following table summarizes the options provided by membership in each of the default Sitecore
client security roles:

Role Function

Sitecore Account Managing | Access to user, role, and domain management features.

Sitecore Client Authoring Access to content authoring features in the Content
Editor, the Page Editor, and the other applications for
content authors.

Sitecore Client Configuring Access to item configuration features in the Content
Editor.

Sitecore Client Designing Access to design features in the Content Editor and the
Page Editor

Sitecore Client Developing Access to the Developer Center and other development
features.

Sitecore Client Maintaining Access to data template management features.

Sitecore Client Publishing Access to site and item publishing features.

Sitecore Client Securing Access to the Security Editor and the other features
associated with assigning access rights.

Sitecore Client Translating Access to the content translation features.

Sitecore Client Users Allows users to log in to Sitecore clients. All of the other

Sitecore client roles are members of the Sitecore Client
Users role. Users in any Sitecore Client role are
automatically members of the Sitecore Client Users role.

Security administrators use the following roles to restrict the features provided by membership of the
Sitecore Client Authoring role. Administrators can make less sophisticated users members of these
roles after assigning them the Sitecore Client Authoring role.

Role Function
Sitecore Limited Content Limits features to provide a simplified Content Editor
Editor interface.

Sitecore Limited Page Editor | Limits features to provide a simplified Page Editor
interface.
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Role Function
Sitecore Minimal Page Removes the ribbon from the Page Editor.
Editor

The following roles simplify security administration by providing default access rights to various
branches in the database, as well as including membership of the relevant Sitecore client roles:

Role Function

Author Provides access rights to the /sitecore/content
branch of the content tree. Member of Sitecore Client
Authoring.

Designer Provides access rights to the areas of the content tree

required when making design changes. Member of
Sitecore Client Designing.

Developer Provides access rights to the areas of the content tree
required during site development and maintenance.
Member of Author, Designer, Sitecore Client
Developing, Sitecore Client Maintaining, and Sitecore
Client Configuring.

Sitecore also provides default roles to control access to features of the Online Marketing Suite (OMS):

Role Function

Analytics Content Profiling Provides access to maintain analytics profiles.
Analytics Maintaining Provides access to the Marketing Center.
Analytics Reporting Provides access to Sitecore Analytics reports.

If the default Sitecore roles do not meet your exact requirements for controlling the user interfaces,
the access rights in the Core database give more precise control over which features Sitecore
exposes to each user or role.

Important

To eliminate unnecessary features in the user interface and minimize the potential for users to invoke
features by mistake, users should be members of the fewest possible roles. The only exception to this
rule is the limited and minimal roles described previously; users should be members of these roles
whenever possible. Most users should only be members of the Sitecore Client Authoring role. When
users require additional functionality, security administrators can give them additional roles.

Important
Administrators have access to every feature, regardless of role membership. Minimize the number of

administrators.
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6.2 Security Presets

Security presets allow users to apply lists of access rights predefined by security administrators to
items.

Security administrators use security presets:
e To simplify the process for end-users to apply access rights to content.
e To define common lists of access rights for users to apply to content.
e To provide single-click user interface components to apply lists of access rights that would
otherwise require multiple actions.

You can access the security presets in the Content Editor, in the Presets group on the Security tab,
and in the Security Editor, in the Presets group.

Tip
To minimize security administration, use security inheritance whenever possible.

6.2.1 How to Create a Security Preset

For the name of the security preset definition item, use a value appropriate for the command in the
ribbon that will invoke this security preset.

To create a security preset by defining access rights through the user interface:

1. Inthe Content Editor, selectthe /Sitecore/System/Settings/Security/Presets
item.

2. Inthe Content Editor, insert a security preset definition item using the
/System/Security/Security Preset datatemplate.

3. Inthe Content Editor, in the Data section, in the Security Preset field, define access rights.
To create a security preset by copying access rights from an existing source item:

1. Inthe Template Manager or the Content Editor, select the source standard values item or
the individual item.

2. Inthe Template Manager or the Content Editor, show the standard fields. For instructions to

show the standard fields, see the section How to Show or Hide the Standard Fields.

3. Inthe Template Manager or the Content Editor, show raw field values. For instructions to
show raw field values, see the section How to Show or Hide Raw Values.

4. Inthe Template Manager or the Content Editor, in the Security section, in the Security
field, select the value, and then copy it to the Windows clipboard.

5. Inthe Template Manager or the Content Editor, hide the standard fields. For instructions to
hide the standard fields, see the section How to Show or Hide Raw Values.

6. Inthe Content Editor, selectthe /Sitecore/System/Settings/Security/Presets
item.

7. Inthe Content Editor, insert a security preset definition item using the
/System/Security/Security Preset data template.

8. Inthe Content Editor, in the Security section, in the Security field, paste the value from the
Windows clipboard.

9. Inthe Content Editor, hide raw field values. For instructions to hide raw field values, see the
section How to Show or Hide Raw Values.
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6.2.2 How to Apply a Security Preset

By default, to apply security presets, a user must be an administrator, or a member of the Sitecore
Client Securing role.

Apply security presets using the Content Editor or the Security Editor.
Tip
Use Security Editor when applying access rights to multiple items.
To apply a security preset using Content Editor:
1. Inthe Content Editor, select the item.
2. Inthe Content Editor, click the Security tab.

3. Inthe Content Editor, on the Security tab, in the Presets group, click a security preset
command. Sitecore copies the access rights defined in the Security Preset field of the
security preset definition item to the selected item.

To apply a security preset using the Security Editor:

1. Inthe Sitecore desktop, in the lower left corner, click the Sitecore button, and then click
Security Editor. The Security Editor appears.

2. Inthe Security Editor, select the item.

3. Inthe Security Editor, in the Presets group, click the security preset command. Sitecore
copies the access rights defined in the Security Preset field in the security preset definition
item to the selected item.
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6.3 Data Template Field Security

Data template field security separates the security rights that control access to an item from the
security rights that control access to the individual field values in that item.

Developers use field security:
e To hide fields in the editing interfaces from some users.
e To make fields in the editing interfaces read-only for some users.
) ;I_'oI jlllow some accounts to update field values while preventing others from updating those
ields.

For example, for search-engine optimization (SEO) purposes, an organization that uses the value of a
data template field to populate the HTML <title> element may not want all users with write access
to other fields to have write access to that field. Only certain users with write access to those items
should also have access to update the fields used for SEO. You can meet this requirement with field
security.

By default, access rights in the item define access rights to all fields in the item. If a field defines
access rights, the user must have explicit field security access as well as access to the item
containing the field.

How to Configure Data Template Field Security
To configure data template field security:

1. Inthe Template Manager or the Content Editor, select the data template field definition
item.

2. Inthe Template Manager or the Content Editor, click the Security tab.

3. Inthe Template Manager or the Content Editor, on the Security tab, in the Security group,
click the Assign command. The access rights dialog appears.

4. In the access rights dialog, grant and deny the field read and field write access rights for one
or more accounts.
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Sitecore Client RSS Feeds

This chapter describe Sitecore client RSS feed features.™ RSS feeds syndicate
information in a standard XML format. Sitecore client RSS feeds expose information
and features to CMS users using the RSS XML format. CMS users can access
Sitecore client RSS feeds using any RSS reader.

This chapter begins with an overview of Sitecore client RSS features, and then
describes Sitecore client RSS configuration options.

This chapter contains the following sections:
e Sitecore Client RSS Feeds Overview

e Sitecore Client RSS Feeds Configuration

'2 For more information about Sitecore RSS features, see the Presentation Component Cookbook at
http://sdn.sitecore.net/Reference/Sitecore%206/Presentation%20Component%20Cookbook.aspx and
the Content Author’'s Cookbook at
http://sdn.sitecore.net/End%20User/Sitecore%206%20Cookbooks.aspx.
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7.1 Sitecore Client RSS Feeds Overview
Sitecore client RSS feeds expose CMS features as Really Simple Syndication (RSS) feeds.™

Sitecore manages the Sitecore client RSS feed definition items under the
/Sitecore/Content/Applications/Syndication/Feeds item in the Core database.

7.1.1 Workflow Feed

The workflow feed syndicates information about items in a workflow.
The workflow feed includes an RSS entry for each state change for each item in the workflow.

The workflow feed appears as an RSS icon for each type of workflow shown in the Workbox.

7.1.2 Workflow State Feed

The workflow state feed syndicates information about items entering and exiting a workflow state.

The workflow state feed includes an RSS entry for each time that each item in the workflow enters or
exits the workflow state.

The workflow state feed appears as an RSS icon for each state in each workflow shown in the
Workbox.

7.1.3 Item Updated Feed

The item updated feed syndicates information about updates to an item, and optionally about updates
to its descendants.

For items associated with a workflow, the item updated feed includes an RSS entry for each workflow
state change. For items not associated with a workflow, the item updated feed includes an RSS entry
for each new version in each language.

The item updated feed appears as the Subscribe command in the Proofing group on the Review tab
in the Content Editor. You can choose to subscribe to changes to an item, or to changes to the item
or any of its descendants.

3 For more information about RSS, see http://en.wikipedia.org/wiki/RSS (file format). For more
information about Sitecore RSS features, see the Presentation Component Cookbook at
http://sdn.sitecore.net/Reference/Sitecore%206/Presentation%20Component%20Cookbook.aspx.
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7.2 Sitecore Client RSS Feeds Configuration

This section describes configuration of Sitecore client RSS feeds.

7.2.1  The ClientFeeds.MaximumltemsinFeed Setting

The value attribute of the /configuration/sitecore/settings/setting elementin
web.config with name ClientFeeds.MaximumItemsInFeed specifies the maximum number of
items to include in a Sitecore client RSS feed.

7.2.2 The ClientFeeds.ltemExpiration Setting

You can set the value attribute of the /configuration/sitecore/settings/setting element
in web.config with name Clienteeds.ItemExpiration to control the expiration of Sitecore
client RSS syndication items. A value of zero (“0”) for the ClientFeeds.ItemExpiration setting
specifies that items do not expire. If you set this value to a positive integer, then RSS feed items on
managed Web sites expire from RSS feeds after the specified number of days.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 62 of 62



	Introduction
	Common Procedures
	Common Procedures
	How to Select a Database in the Sitecore Desktop
	How to Show or Hide the Standard Fields
	How to Show or Hide Raw Values
	How to Show or Hide the Developer Tab
	How to Copy the ID or Path of an Item to the Windows Clipboard
	How to Enter a Class Signature


	Data Templates and Items
	Item Appearance
	Icons
	How to Set the Icon for an Item
	How to Set the Default Icon for All Items Based on a Data Template
	How to Change the Default Icon for All Items
	How to Configure the Icon Selection Menu

	Hidden Items
	How to Show or Hide Hidden Items
	How to Show or Hide an Item

	Protected Items
	How to Protect or Unprotect an Item

	Item Styles
	How to Configure the Style of an Item Name in the Content Tree

	Display Name
	How to Set the Display Name for an Item

	Context-Sensitive Help
	How to Set Item Context-Sensitive Help


	Data Template Sections
	Data Template Section Icons
	How to Set a Data Template Section Icon
	Data Template Section Sort Order
	How to Sort Data Template Sections
	How to Set the Sort Order Property of a Data Template Section Definition Item


	Data Template Fields
	Data Template Field Headers and Context-Sensitive Help
	How to Set the Title for a Data Template Field
	How to Set Context-Sensitive Help for a Data Template Field

	How to Style a Data Template Field
	Data Template Field Sort Order
	How to Sort Data Template Fields
	How to Set the Sort Order Property of a Data Template Field Definition Item

	Rich Text Editor (RTE) Configuration
	RTE Profile Definition Item Reference
	How to Configure RTE Profiles
	How to Determine the Path to an RTE Profile
	How to Set the Profile for an RTE Template Field Definition Item
	How to Add Features to an RTE Profile
	How to Set the CSS Used by RTE Fields
	How to Limit the CSS Styles Visible in RTE Fields
	How to Configure the RTE HTML Element Types Drop-Down Menu
	How to Enable Snippets in an RTE Profile
	How to Add a Snippet to an RTE Profile
	How to Control the Markup Inserted by the Enter Key
	How to Disable the RTE HTML Tab for Some or All Users


	Custom User Interfaces in Data Templates
	The IFrame Field Type
	How to Create an IFrame Data Template Field

	Item Editors
	How to Configure Item Editors
	How to Create a Custom Item Editor


	Insert Options

	Data Validation
	Validation Overview
	Types of Validation
	Data Template Field Validation
	Field Type Validation
	Item Validation
	Standard Validation
	Global Item Validation

	Validation Error Levels
	Configuring Validation Rules
	How to Configure Quick Action Bar Validation Rules
	How to Configure Validate Button Validation Rules
	How to Configure Validation Bar Validation Rules
	How to Configure Workflow Validation Rules
	How to Create a Workflow Command or State Validation Action
	How to Configure Validation Rules for All Instances of a Data Template Field Type
	How to Configure Validation Rules for All Items:
	How to Configure Validation Rules for an Individual Item or All Items Based on a Specific Data Template
	How to Configure Validation Rules for a Specific Data Template Field
	Default Item Validors
	Default Field Validators

	Registering Validators
	How to Register a Validator
	How to Register a Regular Expression Field Validator
	How to Register an Integer Field Validator
	How to Register an Integer Range Field Validator
	How to Register a Maximum Length Field Validtor
	How to Register Validators for Specific Items and Items Based on Specific Templates
	How to Disable Default Validation Rules
	How to Override the Default Error Level for a Validator

	Custom Validators
	How to Implement a Custom Validator
	How to Implement a Custom Validator

	Validation Actions
	How to Create a Validation Action
	How to Use a Validation Action


	The Page Editor
	Page Editor Overview
	The Design Pane of the Page Editor

	Placeholder Settings
	How to Create a Placeholder Settings Definition Item
	How to Configure Placeholder Settings for a Data Template or an Individual Item

	Page Editor Modes
	How to Determine the Page Editor Mode
	Page Editor Modes

	Edit Frames
	How to Implement an Edit Frame Menu Command
	How to Define an Edit Frame Menu
	How to Insert an Edit Frame in a Layout or Sublayout
	How to Insert an Edit Frame in an XSL Rendering
	Edit Frame Properties

	The Field Editor
	How to Use the Default Field Editor
	How to Implement a Custom Field Editor


	Security Based Configuration Features
	Sitecore Client Security Roles
	Security Presets
	How to Create a Security Preset
	How to Apply a Security Preset

	Data Template Field Security
	How to Configure Data Template Field Security


	Sitecore Client RSS Feeds
	Sitecore Client RSS Feeds Overview
	Workflow Feed
	Workflow State Feed
	Item Updated Feed

	Sitecore Client RSS Feeds Configuration
	The ClientFeeds.MaximumItemsInFeed Setting
	The ClientFeeds.ItemExpiration Setting



